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Gears Purity is an automation brick for batch or continuous (real-time) analysis of samples for the
determination of compound purity/potency. It allows the configuration of analysis methods (SOPs) by experts,
streamline analysis by chemists, and generates customizable reports with purity results.

This document is intended to help you configure and run a batch purity analysis from the Mgears platform.

The Workflow

First, launch Mgears from the Mnova Tools ribbon. The dialog with the usual six tabs will open.

= o @; MestReNova MASS

File Home View Molecule Prediction a alysi Database Verification Elucidation Chemometrics Tools Analysis Quantitation

=, & \ % @ - .
o = ~4=-$E k[ D) (= B
. 2 =) . NN = X= . “% =
Chemical Shift Edit Run Import Export Report i NMR Mgears |[Mgears MyGears MyGears Reaction Mnova Mnova  View Mnova
Perturbation Script Script « = = = Tools Viewer Workflows Monitoring Screen 1H Screen 19F Screen Result
Binding Scripts Script Tools Mgears Reaction Monitoring Screen

E Input

In the Input tab, select the data files for analysis by Mgears. Input files can come from Disk directories, a
database (DB), or from Real-Time acquisition, and must contain some metadata under the Comment field of
the Parameters Table, which will be used for purity determination.

The minimum required metadata includes SW: Sample Weight, MW: Sample Molecular Weight, and CR:
Reference Compound. In some cases, it may also be necessary to define other parameters such as RW:
Reference Weight.

More parameters can be added and read by the Purity plugin such as SM: followed by a molecule in smiles
format, or NS: for Number of scans, etc. Valid values are listed below.

All metadata must be entered one after another as shown below. A semi-colon delimiter is also acceptable.

Valid values are:

Parameters

@ & B %

Experiment:
EX: Report Copy Setup Customize
Sample ID: Parameter Value
SID: 1 Data File Name | E:/data/gNMR samples/AZ/632_A
Sample Weight:
ES{“;: Weiskt SW:11.631
eference Weignt. RW:8.182
RW: ol CETTEL MW:384.2538
MW: CR:TCNB
Molecular Weight:

Concentration Reference:

CR:

3 Origin Bruker BioSpin GmbH
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In this guide, we will use data from a Disk directory. So, in the Disk section, click on - and choose the
directory from which your data files will be retrieved.

Q Automatic Detection é Experiments Selection

| Main Directory: |C:;‘Users,‘Usuario]Desktop/Datasets/Durity{
Optional Directory:

;:xg[f_@

Master File:

Use the Automatic Detection mode, with which Mgears will use the saved masks to find experiment files. You
can manually add file masks to the Mask manager under the Settings tab, if needed.

o —

Q Automatic Detection | = Experiments Selection

Main Directory: C:/Users/Usuario/Desktop/Datasets/Purity
Optional Directory:

Master File:

Use the Automatic inspection button @ to check whether the experiments detected correspond to your
selection criteria.

al} Experiments Found: 3 ? X

List of detected experiments:
Experiment: SAMPLE 1
mnova: C:/Users/Usuariof/Desktop/Datasets/Purity/Sample 1.mnova

Experiment: SAMPLE 2
mnova: C:/Users/Usuario/Desktop/Datasets/Purity/Sample 2.mnova

Experiment: SAMPLE 3
mnova: C:/Users/Usuario/Desktop/Datasets/Purity/Sample 3.mnova

OK Cancel

For advanced input selection, you can configure the options in the Advanced and Filtering sections. You can
for instance use the grouping options to allow Mgears recognize and analyze replicate samples together.

wL LD LI LngLUgs apny VP PG SIS FIIUVE LULUEG

&
Advanced Options
Vv
Allow More than One Experiment of Each Type Join Folders with Similar Name
Experiment Selection Mode: FID From: 31 Dec 1969 all | 115 31 Dec 1969 =
Preview Subset Only | 1000 = Regular Expression to Adapt Match / | |~

Regular Expression Filter by Name Only

Y Filtering String:
| Substring Matching -ﬁ

Filter  Mapping File:

»Resume ": Load Settings # Save Settings ﬁ Import Settings ﬁ Export Settings @ Cancel °Run
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V¥ processing

In the Processing tab, you can either add a processing template to your analysis, as in this example, enable
the Advised Processing to automatically apply the best processing options to your spectra, or upload a script
to allow for more advanced and customized processing options.

°a Mnova Gears ? X
B Input J\? Processing ﬁ%] Plugins @ Design B Qutput Q Settings

Solvent

___Blind Regions
+| Processing Templates
Template Type
1 C/Users/Usuario/Desktop/Datasets/Purity/1/1H.mnp 1H

ﬁ'ﬁ‘l Plugins
In the Plugins tab, select and add the Purity plugin.

‘uﬁ. Mnova Gears

E Input f\b Processing i'e—:,‘-‘] Plugins Design B Qutput 'a' Settings

i SQA S
&@ Verify 2
% Concentration ‘
i-'ﬁ - Remove
- £E
\r DB Search New
.i.,ﬁ SMA Custom Plugin
i_iﬁ QC Profiling -
= . Delete
&# Multiplet Report Custom Plugin
i IUPAC Name 552)
N7 MS Scan Purity
icc_' Peak Report Plugin Settings
&# Mpublish
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The added plugin will appear on the right-hand side of the dialog. You should now click on Purity Plugin
Settings to configure the analysis parameters.

%4 Mnova Gears ? X

E] Input jff Processing .QE“;I Plugins B Design [3 Qutput 'n'Settings

.-i SQA ’ ﬁ Purity
& Verify Add
i&'— Concentration ‘
Remove

Purity +
=
n-' DB Search o
&# QC Profiling Custom Plugin
iiﬁ Multiplet Report -

IUPAC Name Delete
%@ MS Scan ﬁ
&# Peak Report Purity
&7 Mpublish Plugin Settings
|

” Resume AE!: Load Settings '!:' Save Settings m Import Settings L"I Export Settings @ Cancel ° Run

In the Purity Settings dialog, you can click on - to add the Experiment library. This is useful if you already
have one or more saved experiments that you want to invoke and use with your samples. In this case, a string
indicating the experiment name must be added to the parameters table of each sample, “EX:
ExperimentName” or “Experiment: ExperimentName”.

Then, select and add the References library containing all the reference compounds used in your analysis.

%

w (.
Load Settings  Save Settings

Experiments Library: C:/Users/Usuario/Desktop/Datasets/Purity/NewlLibrary
References Library: |C:/Users/Usuario/Desktop/Datasets/Purity/Referencelibrary.data

Options Report

Now, in the Options tab, configure the purity calculation parameters. Check the Autodetect Replicates option
if your analysis data include sample replicates or experiment repetitions. Mgears will then automatically
detect and group such samples. In this case, replicate spectra must be grouped in a same Mnova document,
otherwise it may be necessary to correctly configure input grouping options. You can always contact our team
to support you in your workflow implementation.

Options Report

Replicates
v/ Autodetect Replicates
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Then, choose the peak integration method you want to apply...

e Sum-based integration
e Peak-based integration (using global spectra deconvolution, GSD)
e Edited sum integration (a combination of sum- and peak-based methods).

...and the desired options for the reference peak:

¢ Remove Reference signal: can be checked to ignore the reference signal in multiplet analysis and
auto-assignments when using the default analysis.

e Autoadjust Reference: can be checked to automatically detect the highest intensity reference peak
and center it within the reference range.

Options Report
Replicates
Autodetect Replicates

Default Integration Method

Sum ® Peaks Edited Sum
Reference
| Remove Reference Signal /| Autoadjust Reference

In the Multiplet Calculation Options section, you should first decide if you want to base the calculation on all
multiplets (check Use All Multiplets) or otherwise (manually set the number of multiplets to be used).

Multiplets Calculation Options

Method:
& Minimum RSD Multiplet Average Calculation: Weighted Average w2

Scoring Rules
Hybrid Method

-

Autoselect Multiplets: 3~ Use All Multiplets

When integrating a number of multiplets (# all multiplets) a method for their autoselection should be defined.
You can either:

e select multiplets that give the smallest RSD (Minimum RSD);

e rank multiplets using the Multiplet Autoselection rules (Scoring rules);

e orgoforaHybrid method in which multiplets are first ranked by scoring rules and then by the smallest
RSD.

Multiplets Calculation Options
Method:
@ Minimum RSD
Scoring Rules
Hybrid Method

Multiplet Average Calculation: Weighted Average l

-

Autoselect Multiplets: 3~ Use All Multiplets
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If you choose one of the latter two options, custom scoring rules can be defined in the Expert section. Here, it
is possible to:

1. Ignore multiplets with a gGSD value that is greater than a fixed threshold

2. Discard mismatched assignments when available
3. Prioritize and penalize multiplets over others

Method:

Minimum RSD Multiplet Average Calculation: Weighted Average hd
o Scori
.ng L2 Autoselect Multiplets: 3 T| | Use All Multiplets
Hybrid Method
| Expert

Restore Default
qGSD Threshold: 99.99 = | Discard Mismatched Assignments when Available D
Rules to Rank Autoselected Multiplets
Prioritise Aromatic Hs Penalise Undefined Multiplets
/| Prioritise Clean Multiplets Penalise Multiplets with Several Nuclei Score Threshold: 0.60 ~
Use Scores from Assignments Penalise Wide Multiplets

OK Cancel

Finally, decide the Multiplet Average Calculation method:

e Simple Average: the mean average of the concentrations will be calculated.
¢ Weighted Average: the concentration with the sum of the integrals, divided by the sum of the nuclei
and multiplied by the scaling factor.

Multiplet Average Calculation: |Weighted Average
Weighted Average

Autoselect Multiplets: '3 |Simple Average

Now go to the Report tab to configure the results report. Click on - and upload a Custom Layout Template
to apply to your report, or otherwise use the Default Layout included with the plugin (you can Download and
view this default layout, edit it as needed, then save it to use it as a custom layout).

If your layout template has only one page, you can check the Apply Single Page Template to Each Page to
apply it recursively to all the pages of the results report.

Options Report

No Layout
Default Layout Download
@ Custom Layout Template C:/Users/Usuario/Desktop/Datasets/Layout template.mnova
Apply Single Page Template to Each Page
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P

Then, check the sections you want to include in the report: Title, Main Result, Multiplet Table, Standard

Information, Analysis Conditions, Experiment Information, Replicate information, Errors and Hints.

Font style can be customized for each of the report sections. Click on A<“, choose your preferred font options,
and then click on OK to save your choices.

] (=
Load Settings  Save Settings
Experiments Library, Qﬁ Select Font e 7
References Library:
-{ Font Font style Size 3
Options | Repol [ TEEIGIE Normal 8 |
No Layout MS Serif Normal a6 |~ |
Default Layout MS Shell Dig 2 Bold 7 Download
e Custom Layout MS Ul Gothic Italic 8 :_nnova
Apply Single 1 ‘ Bold Italic ¥ | |9 v
| Heport Title Effects Sample Aa |
| Heport Main Res Strikeout Ar
v Heport Multiplet: Underline AaBbYyZz L Ax
| Heport Standard  Writing System o Ay
Any
v Heport Analysis Aa
| Heport Experim OK Cancel A
| Heport Replicate Tnformation Aa
v'| Report Errors and Hints
OK Cancel
The Multiplet Table can be customized by clicking on a, as shown below:
/| Report Multiplets Table ﬁ- A A
{b Customize Results Table ? :*S X
Multiplet Range NN SNR Result
- s
Visible Name Multiplet Range NN SNR Result
tim e —
. | |Visible
ting OK Cancel
|
‘\
P/N 263 R1
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Standard Information can include sample and/or reference compound information. Click on S to open the
settings dialog.

NO Layout

Default Layout

pwnload

{h Standard Information Settings ? X
@ Custom Layout Template

Apply Single Page Temf - 5ample Information

V| Report Title v/ Section's Title Test Compound
V| Report Main Result V| Sample Mol Weight 'Molecular Weight [g/mol]
v| Report Multiplets Table V| Sample Weight Mass [mg]
/| Report Standard Informatiq
-Reference Information
v\ Report Analysis Conditions
| Reference Name Name
V| Report Experiment Informz
v Reference Weight Mass [mg]
V| Report Replicate Informatiq
Reference Mol Weight Molecular Weight [g/mol
/| Report Errors and Hints . ohi [g/mol}
Reference Purity Purity [%)] -
) - Cancel
& . . o | Y Reference Concentration:  Concentration —
; Save Seftings ™ Import]| | |
T - . e

OK Cancel

Top Tip! The Report Errors and Hints option is an excellent way to get relevant feedback when an analysis
fails. An error message and its possible cause will be written in the result files, as seen below:

45000
Critical Error in Purity: The Reference is not defined in the experiment This experiment will be skipped
Hint: Chedk that the spectrum has a reference defined In the comments or In the parameters. Example: CR:DMP |
40000
Critical Error in Purity: The Reference Molecular Welght (s not defined. This spectrum will be skipped |
Hint: Chedk the definition of the reference in the References Library 135000
Critical Error in Purity: The Sample Molecular Welght (s not defined. This experiment will be skipped L30000
Hint: Chedk that the parameter (Molecular Welght or MW) s defined in the commeents of in the parameters of the spectrum.
Ifitis, it shoud end by @ (Example MW:1234)
25000
Critical Error in Purity: The Sample Weight is not defined, This experiment will bejskipped
Hint: Chedk that the parameter (Sample Weight or SW) is defined in the comments gf in the parameters of the spectrum.
Ifitis, it shoud end by : (Bcample SW: 1234) 20000
F15000
10000
‘ -
l.l. KL l_ Jl_ - -__-”-1 A -0
3 12 11 10 9 8 7 6 5 4 3 2 1 0 1 -2
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(o

Once all the Purity Settings have been completed to your satisfaction, click on OK, and proceed to the next

Mgears tab.

%

- -
Load Settings  Save Seftings

Experiments Library: C:/Users/Usuario/Desktop/Datasets/Purity/NewLibrary
References Library: C:fUsersfUsuario/Desktop/Datasets/Purity/Referencelibrary.data

Options Report

No Layout
Default Layout
Custom Layout Template

Apply Single Page Template to Each Page
+ Report Title
+ Report Main Result

<

Report Multiplets Table
Report Standard Information
Report Analysis Conditions

< [ [«

Report Experiment Information

<

Report Replicate Information

<

Report Errors and Hints

OK

—3

Download

Ax

Ar
£ As
L Au
As
Ar
Ax

Cancel

Top Tip! When running routine gNMR analyses with the same configuration settings, you can save these
settings once and then load them easily for future analyses. A “.data” file will be created and saved to the

directory of your choice.

Qﬂ Purity Settings

w (8
Load Settings Save Settings

Experlments Lil—u—:r\l~ CNlcarell leniariag

References Libi File name: ’ batch_gNMR_parameters

Options Save as type: *.data

P/N 263 R1
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Design

When running various analyses on a given dataset, you may want to upload an Mnova layout template or a
Script in the Design tab to produce a final, customized report that combines the results of all the analyses. For
the current Purity analysis, this is not needed, so let’s proceed to the next tab.

B Output

In the Output tab, select a directory in which to save your analysis results, and decide whether to include an
Mnova or PDF results file, or save the results to a connected DB (please refer to the Mgears manual for more

details about the output tab).

qu ,
+D_| Input J'(° Processing % Plugins L% Design B Output -Q Settings
Disk
Directory: C:/Users/Usuario/Desktop/Results/Purity
)| /| Mnova

Save Mnova Document in:
Save a Copy of the Mnova Document with the Raw Data
= (/| PDF
® Save in Results Folder
Save with the Raw Data
Save PDF in:
Add Analysis Type in the Name of the PDF Embed in Mnova Decument

=P | DB
Expert

" Resume E"_: Load Settings '-% Save Settings m Import Settings ﬁ Export Settings

. R .
Now click on o " to start the analysis.

P/N 263 R1

Save PDF in a New Record

® Cancel ° Run
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The output folder

Once the analysis has completed, you can go the directory specified previously to check the results. The output
folder is named according to the date and time at which your analysis was conducted and contains all the
output generated in the current evaluation.

Purity »

Name

Css

data

2021-06-01T09.23.44

documents

images

js
pdf

2021-06-01T09.23.44

2021-06-01709.23.44.resume

@ Purity-Results

settings.mgrs

The Mnova and PDF results files are saved under “documents” and “pdf”, respectively.

An HTML report is also created with all the analysis results; each row contains the average Purity (% £ RSD)

result for a sample and links to the corresponding Mnova and PDF results files.

Mgears Purity Results

Parameters

Parameter
Results Directory
Started On

Completed On

Detailed Results

Show 5 v entries

Value

C:/Users/Usuario/Desktop/Results/Purity/2021-06-01T08.23 44

2021-06-01T09:23:44

2021-06-01T09:24:24

Capy csv Columns PDF Print Search:
# *  Purity Mnova File Pdf File
1 99.42%+-0.24 SAMPLE 1.mnova SAMPLE 1.pdf
2 100.16%+-0.24 SAMPLE 2 mnova SAMPLE 2.pdf
3 100.38%+-0.25 SAMPLE 3.mnova SAMPLE 3.pdf

Showing 1 to 3 of 3 entries

You can Copy, Print, or save these global results into a CSV or PDF file.

P/N 263 R1

Previous

Next
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Results review with the Mgears Viewer

Detailed Purity results can be reviewed in the Mgears Viewer. Click on L and select the Purity analysis output
folder.

Mgears Viewer

w =208 EEE

The experiment results will be loaded into the Mgears Viewer dialog. Select a sample in the table or well plate.
The detailed results will appear in the Results section, and the corresponding Mnova document will open.

Purity Results include the global Purity value (99.4226 in this example), the absolute Concentration, the
Standard Deviation SD, and the Relative Standard Deviation RSD. The Purity and RSD values are also pasted
into the Mnova document.

The autoselected multiplets are highlighted in green and included in the Multiplet table in the Mnova report
with the corresponding calculated purity.

Other experimental and analysis information is included to the report (as predefined in the settings).

Mgears Viewer & x ‘OW SAMPLE 1* x
w S0 & B Ee i _
| e ” NMR Purity Results
Purity : 99.42 T Compaun
# Title Document Mestrelab Research RSD%: 0.24% Global Purity Result E'E-:r;;ﬁ-;g.fmﬂ 342538
_ o Purty Reference Material
1 SAMPLE.T SAMPLE 1.mnova C:/Users/Usuario/Desktop/Re SW:i1.631 pe e oy e TG
RW:8.182 = o ‘G | Concentrabion: N
2 SAMPLE 2 SAMPLE 2.mnova C:/Users/Usuario/Desktop/Re MW:384.2538 ) A X
) CR:TCNB 10 (dd) 25(s) “l191t) Precessiog/inaiyss Condtins
3 SAMPLE 3 SAMPLE 3.mnova C:/Users/Usuario/Desktop/Rq 7.29 348 ol .06 St S e
#H=1 #f=3] B |#H=3 S i et
4 » . 3 ] Arabte Inte ration Mithad: Peals
6(s) | |12 (dd) 3(s) | |18(m)| 2031 (d)| © Referar Corpoundregaion e Paka
Rl — 8.90 7.37 531 | | 3.94 2/p3
Purity Result - [#H=1] | #H=1 |#H=1| | #H=2] #H=6 T e
Purity: 99.4226 11 (t)
Concentration: 3.0094 223
SD: 0.2430 #n=1 3
RSD: 0.2444 6 : 1 18 R )
Multiplets ! | el 1
Name ShiftnH_Purity § E: i b S
i2(@a) 7237 i paessl | Autoselected = ‘ :
IA(ENN 7931 (N 5910692 " multiplets for Purity = - :
ORI L0GI SN0 - | a8 7 & s 4 3 2 1 .
6(s)  8.90 1 952392 1H (ppm)
10(dd) 7.29 1 97.8568 —
3s) 5311 101.5863 Multiplet Range NN SNR Result
18(m) 3.94 2 101.3348 12(dd) 7.3922..7.3465 1 7594.41 99.269
25(s) 3.48 3 94.7989 11(t) 7.2579..7.2018 1 11106.15 99.069
20,21(d)2.23 6 97.4087 |19(8) 1.0894..1.0260 3 37644.22 99,592
v
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To review the individual results for each sample, it is possible to use the Mnova Standard Purity plugin. Open
the Purity plugin dialog from the Quantitation tab in the Mnova ribbon.

File Home View Molecule

Concentratio Simple Mixture
Analysis
SMA

gNMR

Then, click on ®~ to load the purity results from the open Mnova document. Sample and reference details,
as well as all spectral multiplets, are loaded into the Purity dialog.

Purity 8 x
= = = .
> S E R E ®
Experiments
Sample Details Reference Details ] E
Mol Weight: ~ | | Name: - || >
Weight (mg): Weight (mg): f!
Results
Purity Average: RSD%: !
5 ;
Name Score Shift Range Hs Purity SNR  Abs| ;
u‘:{}“ﬁ
Purity g x
> 5 E B g & e
Experiments
Sample Details Reference Details E
Mol Weight: 384.2538 * | Name: TCNB v L~
Weight (mg): 11.6310 Weight (mg): 8.182 !
Results
Purity Average: 99.423 RSD%: 0.244 /2
Name  oselec Shift Range Hs  Purity

| .o
>z 4B
4

1 [Mi12dd) 1 7.37 7.3922.7.3465 1 99.269

2 M1 1 7.23 7.2579.7.2018 1 99.069

R

3 Moy 1 1.06  1.0894.1.0260 3 99.592
4 [(Jes) o 890 8.9140.8.8840 1 95.239
5 [J10dd) © 7.29 7.3126.7.2667 1 97.857
6 (3 o0 531 5.3230.5.2930 1 101.586
7 [J18m) o0 394 3.9998.3.8891 2 101335
8 [J25) © 348 3.4987.3.4687 3 94.799

9 [J2021(d) 0 223 2.2535.2.2103 6 97.409

4 | »
Alerts
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You can select/deselect multiplets as preferred. The results will be automatically updated in the Mnova
document and in the Mgears Viewer.

Purity

> LEREBR S

% [g] SAMPLE 1 x

Experiments
Sample Details Reference Details E Test Gonpeurd
Mol Weight: 384.2538 ~ | | Name: TCNB - [~ ::ﬂ:';:ﬂ':.;“hﬂw“”
Weight (mg): 11.6310 Weight (mg): 8.182 Py afarsn vatersl
ight (mg) ght (mg): Q SWe11 631 5 e Ao Ve ma) 1820
Results RW:8.182 o o _oi | Comentration it
; MW:384.2538
Purity Average:  99.169 RSD%: |0.101 ) : L . L [
(2 CR:TCNB 10 (dd)| 129(s)| 119¢t) resseslinins Gdicrs
Name  Autoselected = Shift Range Hs  Puity “| @~ 7.29 3{48 < 106 e Srcaderirg: ore
= f T — —— T ¢ Integrat : P
1 Mi2dd) 1 737 73927346 1 99269 | | %R 6| 2@ 39| [l [20d1@ o Rfuarin Compmrd kg et P
" 8.90 737 | 5.31 3.94 2{23
2 A 723 72587202 1 99.069 535 =t | #H=d | #Hes =y e
3 19(t) 1 106 1.089.1.026 3 99.592 | ?
£ia A 06N 0014 0004 4 oz 230 . :
Mgears Viewer & x ®
e o *
., WHED % A ERE Arahyze g |4
Again
7 # Title Document 6 5 4 3 2 1 0
s 1 SAMPLE 1 SAMPLE 1.mnova C:/Users/Usuario/Desktop/Results/Purity; 1H (ppm)
Multiplet Range NN SNR Result
9 |2 SAMPLE 2 SAMPLE 2.mnova C:/Users/Usuario/Desktop/Results/Purity/| 12(dd) 7.392..7.346 1 7918.10 99.269
11(0) 7.258..7.202 1 11579.53 99.069
‘_‘ 3 SAMPLE 3 SAMPLE 3.mnova C:/Users/Usuario/Desktop/Results/Purity/]
A | »
Results
Purity Result
Purity: 99.1690
Concentration: 3.0018
SD: 0.0998
RSD: 0.1006
Multiplets
Name ShiftnH Purity
12(dd) 17.37' 1 99.2688 |
() 7.2311 199.0692 |
19(t) 1.06 3 99.5917
6(s) 8901 952392
10(dd) 7.29 1 97.8568
3(s) 5.31 1 101.5863
18(m) 3.94 2 101.3348
25(s) 3.48 3 94.7989
20,21(d)2.23 6 97.4087
Click on = to save the new results to the output folder.
Mgears Viewer
] Elk@ O & [H ERE
# Title Document
1 SAMPLE 1 SAMPLE 1.mnova C:/Use

2 SAMPLE 2 SAMPLE 2.mnova C;/Use

2 CAMPDPIE 2 CAMDIFE 2 manmva (+/llce

For more detailed information about Mgears, please refer to the Mgears Manual or to our Resources section
on the web.

You can also read the MyGears Application Note to see how an Automated Triplicate gNMR analysis can be
performed with a single click.
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